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Overview 
Attachmate INFOConnect Airlines Gateway is a combination of software components 
and administrative tools that run on a Windows server. You can use this product to 
manage communication between networked PCs using Attachmate Airlines Client 
Emulation products and any host that supports Mapping of Airline Traffic over Internet 
Protocol (MATIP) including Amadeus, Worldspan, SabreIP, and Galileo/Apollo.  

INFOConnect Airlines Gateway manages communication for networked PCs running 
the following products: 

• INFOConnect Enterprise Edition 

• e-Vantage HAS for Airlines 

• Reflection for the Web 2008, Airlines Edition 

• Verastream SDK for Unisys and Airlines 

For more information about INFOConnect, see the INFOConnect Enterprise Edition 
Product Guide. 

Number of Connections Supported 
The INFOConnect Airlines Gateway supports up to 100 terminal addresses per host 
protocol (MATIP, SabreIP, or ATSTCP). 

New Features 
New features available in this release include: 

• Designated “Works with Windows Vista.” 

• Attachmate implementation of Windows Vista certified installers using the MS 
Windows Installer XML (WIX) open source toolkit and MSI-based deployment 
technologies and customizations. 

• Support for the increased IP addressing and capabilities of IPv6. 

• Sabre NOFEP support — requires a C Common Sabre Application Programming 
Interface (CCSAPI) license from Sabre. 



INFOConnect Airlines Gateway Product Guide 

2 

Major Components 
INFOConnect Airlines Gateway includes the following components: 

Component Description 

Gateway Service The Windows service that provides client-to-host connectivity. 

Gateway 
Administrator 

An application that you can use to configure the connection 
settings for all the networked PCs that will be accessing the 
host. 

Gateway 
Transports 

Software that processes communication for a particular kind of 
network and host. Five transports are available: SABREGW 
(OFEP support), SABRE2 (NOFEP support) MATIPGW, 
UDPFRAD and ATSTCPGW.  

Gateway 
Monitor 

A utility that you can use to monitor communication between 
the client and the Gateway. 

INFOConnect 
Manager 

The user interface for INFOConnect Connectivity Services, a 
package of communication software that runs in the 
background and stores the connection data specified using 
Gateway Administrator. INFOConnect Manager can be used to 
monitor communication between the Gateway and the host. 

Export-Import 
Utility 

A tool that allows you to export data from any INFOConnect 
database into an .ini or .csv file, as well as import data from an 
.ini or .csv file into an INFOConnect database. This utility may 
be used for creating backups, for troubleshooting, or for 
merging multiple INFOConnect databases into a single master 
database. 

CnfEdit A utility that allows you to edit certain configuration files used 
with the Airlines Gateway host transports. 

 

Note: Any networked PC connecting to the INFOConnect Airlines Gateway must use the 
INFOConnect AIRGATE transport or another Gateway-compatible transport. 
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System Requirements 
For production environments, many users install the various INFOConnect components 
on separate computers. Specific requirements will vary based on which components are 
installed, and on other hardware and software components present.  

Note: Attachmate cannot confirm the accuracy of performance, or any other claims 
related to non-Attachmate products. For questions or concerns regarding the capabilities 
of non-Attachmate products, please contact the suppliers of those products. 

INFOConnect Airlines Gateway can take advantage of the additional address space and 
capabilities available through IPv6, and it meets the requirements for Works with 
Windows Vista certification. Follow the Microsoft guidelines for Windows Vista system 
requirements 

The minimum system requirements are covered in the following table. 

System Component Description 

Operating System Windows Vista SP1 or greater 
Windows XP Professional with SP1 or SP2 
Windows 2000 Professional with SP4 
Windows 2000 Server and Windows Server 2003 
with SP1 

Processor 500 MHz Intel Pentium-class 

RAM 128 MB 

Networked PC Components A networked PC connecting to the INFOConnect 
Airlines Gateway must use the INFOConnect 
AIRGATE transport or another Gateway-
compatible transport. 

Additional Requirements Both server and client PC must be connected to a 
TCP network. 

 

Note: INFOConnect Airlines Gateway cannot be installed on Windows NT servers. 
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About This Product Guide and Online Help 
Information about INFOConnect Airlines Gateway is available through this product 
guide and the component Help systems. 

INFOConnect Airlines 
Gateway Product Guide 

This guide provides an overall description of this product 
and the solutions you can create with it. 

Component Help 
Systems 

General help and context sensitive help is available. The 
Help systems uses WinHlp32.exe, which is not included 
with Windows Vista. To open INFOConnect help on 
Vista, you may need to install the Windows Help 
program. For more information see Attachmate 
Technical Note 2294 
http://support.attachmate.com/techdocs/2294.html. 
Technical Note 2294 also contains information on 
resolving the following error message that may appear 
when accessing Help on Vista Windows: There was a 
problem running the macro.(1037). 
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Installing and Getting Started 
You can install INFOConnect Airlines Gateway on any Windows server in your network 
that meets the criteria specified in the system requirements, or on the same computer as 
INFOConnect Enterprise Edition version 9.0. 

Note: When you install INFOConnect Airlines Gateway, you must perform the 
installation directly at the server itself rather than from a PC connected to the server. This 
ensures that the server has all the necessary Windows registry entries. 

Starting with version 3.0, the INFOConnect Airlines Gateway installation uses the 
standard Attachmate Installer Program.  

Installing INFOConnect Airlines Gateway 
You must perform the installation directly at the server rather than from a PC connected 
to the server. You can run the Setup wizard from a download site or from an 
administrative install image. 

To install INFOConnect Airlines Gateway 

Note: You must log on with administrator privileges to install the product. If you do not 
have the necessary access rights, ask your system administrator to elevate your 
privileges. 

1. Run the Setup wizard. 

If you Do this 

Install from a download site Click the download link and run the download 
program. Select a location for the installer files 
and click Next. This extracts the files to the 
specified location and starts the Setup wizard. 

Install from an administrative 
install image 

From the administrative installation point, 
double-click the setup.exe file. 

 

2. From the Setup wizard, click Continue, and then follow the instructions on the Setup 
wizard user interface. 

3. (Optional) To personalize the installation, click the User Information tab and enter 
the name, organization, and Volume Purchase Agreement (VPA) number (if you 
have a VPA). 

Note: The purpose of VPA numbers, which are issued by Attachmate, is to allow 
customer support to expedite service requests.  

4. (Optional) Click the File Location tab and browse to the folder in which you want to 
install INFOConnect to change the default installation folder, . 
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Note: Use the Advanced tab of the installer only if you want to create an 
Administrative installation. The administrative installation does not actually install 
the product, it places an image on a network location for later installation to multiple 
workstations. This network location can be used by deployment tools to access and 
create packages that are deployed to workstations, and end users can perform 
workstation installations by running setup.exe from this location.  

Installer Advanced Tab 
Modify the Advanced tab settings only if you want to create an Administrative 
installation. The administrative installation does not actually install the product; instead, 
it places an image of INFOConnect on a network location for later installation to multiple 
workstations. This network location can be used by deployment tools to access and 
create packages that are deployed to workstations, and end users can perform 
workstation installations by running setup.exe from this location. 

Following are descriptions of the options available from the Advanced tab: 

Option Description 

Install to this PC Installs INFOConnect Airlines Gateway to your 
computer. 

Create an administrative 
install image on a server 

When you create an administrative installation image, 
an image of the product is copied to a network 
location for later installation to multiple workstations. 
This network location can be used by deployment 
tools to access and create packages that are deployed 
to workstations. Also, end users can perform 
installations by running setup.exe from this location. 

Create a log file for this 
installation 

Specifies whether or not a log file is created. The 
installation log file, which provides details about the 
installation, is saved in the user’s temp directory 
(%tmp%) with a generated name that begins with atm. 
To open this folder, launch the Start menu Run 
command and enter %tmp%. 

 

Note: For more information about installation options and customizations, see the 
INFOConnect Enterprise Edition Product Guide. 

Starting and Stopping the Gateway Service 
INFOConnect Airlines Gateway is a Windows service that you must start manually the 
first time you use it. Once you start the service, it restarts automatically each time you 
restart the server on which it is installed. 

Note: You must stop the service if you install a newer version of INFOConnect 
Connectivity Services. 
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You can start or stop the gateway using either Gateway Administrator or Windows 
Control Panel. The service name is ATMIcsGate. 

To start or stop the Gateway service using Gateway Administrator 

1. Start the Gateway Administrator. 

For more information, see “Starting the Gateway Administrator.” 

2. In the path tree, click the name of the computer on which the Gateway is installed. 

3. Do one of the following:  

Click To do this 

Start Start the Gateway. 

Stop Stop the Gateway. 
 

To verify your action, State displays Stop when you request a manual stop and the 
service is in the process of stopping, Stopped when you have successfully stopped 
the gateway and Running when you have successfully started the gateway. 

Starting the Gateway Administrator 
Gateway Administrator is an application that you can use to create, modify, and delete 
the paths used to establish connections between the networked PCs and the host. The left 
pane of the Gateway Administrator application window displays a tree view of the client 
and host paths that are available. As you create new host paths, these paths appear on 
the path tree. 

To start Gateway Administrator 

1. Log in to the server where INFOConnect Airlines Gateway is installed. 

You must run Gateway Administrator directly from the server; you cannot run it 
from a networked PC connected to the server. 

2. From the Start menu, open Gateway Administrator from the Attachmate 
INFOConnect Airlines Gateway Programs group. 

3. The first time you start Gateway Administrator, you are prompted to type and 
confirm a password for this application. Each time you run it subsequently, you 
must type this password. 

The password for Gateway Administrator is the same as the administrator password 
for INFOConnect Manager. If you change the administrator password using 
INFOConnect Manager, the same change is made in Gateway Administrator, and 
vice versa. 

Once you type a valid password, Gateway Administrator starts. 
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Managing Host Connections 
To establish connections between networked PCs and a host, INFOConnect Airlines 
Gateway must receive connection requests from the networked PCs and then establish a 
connection with the host. It does this using paths. 

A path is a named set of configuration data about the connection. The Airlines Gateway 
uses two types of paths: 
• Host paths, which connect the Gateway to the host using one of the five Gateway 

transports: SABREGW (OFEP support), SABRE2 (NOFEP support), MATIPGW, 
UDPFRAD and ATSTCPGW. Host paths can be created using the Configuration 
Translation wizard or the Add Host Paths wizard. 

• Listening paths, which the client PC uses to connect to the Gateway using the 
AIRGATE transport or another Gateway-compatible transport. 

These paths are shown in the figure below: 

 

A configuration translation maps a host path to a listening path. Configuration 
translations are created using the Configuration Translation wizard. 
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Host Paths 
There are two types of host paths: single connection paths and pooled connection paths. 
You can have both a single connection host path and a pooled host path going to the 
same host. For example, if you had one printer and 50 terminals, you might configure the 
printer session to use a single connection path and the terminals to use a pooled 
connection path.  

Single Connection Host Paths 
A single connection path contains configuration data for only one connection to a host. If 
you create single connection paths, you can create one for each networked PC that 
connects to INFOConnect Airlines Gateway. For example, if 50 networked PCs connect 
to INFOConnect Airlines Gateway, you must create 50 single connection paths.  
Using single connection paths does provide greater security because you can assign a 
particular path to each networked PC. 

Pooled Connection Host Paths 
A pooled connection path contains configuration data for multiple connections to a host. 
If you create pooled connection paths, you need to create only one for all the networked 
PCs that connect to INFOConnect Airlines Gateway. For example, if 50 networked PCs 
connect to INFOConnect Airlines Gateway, all 50 can connect to the host using the same 
pooled connection path. 
You should use good judgment for your situation when creating pooled connection 
paths. With multiple users accessing the same path, pooled connection host paths do not 
offer the same security level provided by single connection host paths. 

Determining the Number of PCs Using a Pooled Connection Path 
The number of networked PCs that can use a pooled connection path varies, depending 
on how many host addresses you assign to that path. For example, you could create a 
pooled connection path called MATIP_1 and assign 20 host addresses to that path. Each 
time a networked PC connects to INFOConnect Airlines Gateway and uses that path, one 
of the host addresses is assigned to that PC. Once 20 networked PCs have accessed the 
path, all the available host addresses will be in use, and no other networked PCs will be 
able to access the host using that path. If the pooled connection path contains fewer host 
addresses than the number of networked PCs that will be connecting to INFOConnect 
Airlines Gateway, you must create multiple pooled connection paths. 
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Some things to consider when you are determining the number of PCs that will use a 
pooled connection path: 
• One pooled connection path with many host addresses 

– Advantage: It’s easy to remember the name. 
– Disadvantage: A longer access time during connection of the client slows down 

the connection process. 
• Multiple pooled connection paths with fewer host addresses 

– Advantage: You can group pooled connections by name, such as Accounting, 
Sales, or Second Floor. 

– Disadvantage:  There are more paths to maintain. 

Creating a Host Path 
When you are prompted for a value that must be unique to each host connection, such as 
the terminal address (TA), you can also specify a number in the Multiplier text box. The 
multiplier creates the specified number of automatically incremented values. For 
example, to create a pooled connection path with ten TAs, you would specify the 
beginning TA and then type 10 in the Multiplier text box. 

To create a host path 
1. Start Gateway Administrator. 
2. From the Path menu, click Add host path. 
3. (Optional) Create a host path when creating a configuration translation. 
4. Respond to the prompts in the Host Path wizard. 

The information for which you are prompted varies depending on which transport 
you are using. 

Listening Paths 
When Gateway Administrator is run for the first time, the INFOConnect path used to 
receive incoming client connections is automatically created. (This path is named 
ATM_TCP_1 by default.) When the Gateway service is running, by default, five instances 
of this listening path are active, listening for incoming connections. Depending upon the 
number of anticipated client connections, it may be necessary to increase the default 
number of listening paths by changing the Number listening on the Translations page. 
Configuration translations are the rules for mapping listening paths to host paths. When 
you create a configuration translation, you specify which host path to use to establish a 
connection with the host. If a host path does not already exist, the configuration 
translation wizard prompts you to create one. For more information, refer to the next 
section, “Creating a Configuration Translation.” 
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Creating a Configuration Translation 
Configuration translations are the rules for translating client connection information to 
host connection information. INFOConnect Airlines Gateway includes a Translation 
wizard to assist you in creating configuration translations. Using the Translation wizard, 
you can specify which host path to use based on the configuration of your networked 
PCs. 
You can add more configuration translations as you need them, which allows you to 
create specific rules for connecting clients to host connections as your situation requires. 

To create a configuration translation 
1. Open Gateway Administrator. 
2. From the tree view, select Configure. 
3. From the Translation tab, click Add. 
4. Respond to the prompts in the Translation wizard.  

The information for which you are prompted varies, depending on which transport 
you are using and whether you want to select an existing host path or create a new 
one. 

Sabre NOFEP Communications Protocol Support 
Use the following instructions to connect the gateway with the Sabre No Open Front End 
Processor (NOFEP) system. Customers are required to license CCSAPI from Sabre before 
they connect via INFOConnect.  

Install CCSAPI (the Sabre API) before you install INFOConnect Airlines Gateway 
version 3.0. For information on the API installation, refer to the Sabre documentation.  

To verify access to Sabre 

• Test the following connections: 

– Telnet to access.sabre.com port 30031 (TA access) 

– Telnet to access.sabre.com port 30032 (Agency Pooled TA access) 

– Telnet to access.sabre.com port 30051 (Printer access) 

– Telnet to hsspconfig.sabre.com 389 (LDAP services for NOFEP access) 

To configure csapi.cfg 

CCSAPI takes its configuration settings from the Csapi.cfg file, which must be placed in 
the Windows directory. 

1. From the Windows directory, open Csapi.cfg in Notepad. 

2. Locate the Route names section. 

3. In the FIXEDTERMINALHSSP2 entry (or your own route, if you have created one), 
replace PUT_YOUR_PROVIDED_VALUE_HERE with (one of) the address(es) provided 
to you by Sabre (a six-digit hex number). 
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4. Locate the {hssp2terminalfixed section. 

5. Modify SKIPLEADINGCHARS to equal 3. 

6. Modify EBCDIC2ASCII to equal “NO”. 

7. Save and close the file. 

To define a Sabre NOFEP host path 

1. In Attachmate Gateway Administrator, select Configure in the tree view in the left 
pane. 

2. In the right pane, click Add. 

3. Proceed through the normal steps to configure a Translation. For more information, 
refer to the information in this product guide and Gateway Administrator Help. 

4. When asked for the transport to use, select SABRE2, and then click Next. 

5. When asked for the route name (from Csapi.cfg) enter FIXEDTERMINALHSSP2 or, 
if you have created one, the name of your own route. 

6. Complete the configuration of the Translation. 

Tracing INFOConnect Paths 
In some situations, communication problems might be caused by the transport rather 
than the gateway. To determine if this is the case, you must trace the INFOConnect path 
being used. 

To trace INFOConnect paths 
1. Make sure all users are logged off, then stop the Gateway Service. 

For more information, refer to “Starting and Stopping the Gateway Service.” 

2. From the Start menu, select INFOConnect Manager from Tools menu of the 
Attachmate INFOConnect Airlines Gateway program group. 

3. From the Administer menu, click Administrator login. 
4. Type your password and click OK. 

This is the same password that you use for Gateway Administrator. 
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5. From the Administrator menu, click Trace.  
The Trace Log Options dialog box appears with the following options: 

Enable Trace Log: Select this option to enable the trace log facility.  

Write to Log File: Select this option to store trace information in a file called 
\datadir\Trace.log, where datadir is the name of the INFOConnect data directory 
(this is the Windows directory by default).  

Add Time Stamps: Select this option to add a time stamp to each entry that is 
logged.  

Show Xmt/Rcv Buffer Contents: Select this option to show the contents of data 
buffers that are being transmitted and received. This will generate a listing of both 
the hexadecimal value of each byte plus the character. The format will be 16 bytes 
per line. 

Trace Library API Calls: Select this option to show the returned results from 
routines that INFOConnect called in a library. The APIs that are logged are 
IcLibOpenChannel, IcLibOpenSession, IcLibCloseChannel, IcLibCloseSession, 
IcLibIdentifySession, IcLibInstall and IcLibTerminate. This option also cause the 
library load and free calls to be logged. 

Trace IC_OK Results: This option works in conjunction with the Trace Library API 
calls. If not selected only API calls that return a result other than IC_OK will be 
logged. Enable Trace Log, Write to Log File, Add Time Stamps, Show Xmt.rcv Buffer 
Contents, Trace Library API Calls, and Trace IC_OK Results. 

6. Generally you will select all options and click OK.  

7. From the task bar at the bottom of the screen, click the INFOConnect Trace Log icon. 
The INFOConnect Trace Log window appears. 

8. From the Options menu of the INFOConnect Trace Log window, select Session 
Trace. 

9. For the All paths, Paths with trace, and Templates with trace options, select Libraries, 
and then click OK. 

10. From the Administrator menu, click Exit INFOConnect. 
11. Start the Gateway. 
12. Test opening a session with the host. 

INFOConnect Manager traces the communication at the transport level and records 
the information in the Trace.log file in the install folder on the server where Gateway 
Monitor is installed (by default, ..\Program Files\Attachmate\Infocnee\Gateway). 

Note: The Trace.log file can become very large, so be sure to delete it after you 
complete each trace. 
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Editing a Path 
You can edit existing host paths in Gateway Administrator. 

Note: If you modify a path that is currently in use, no disruption occurs in 
communication, but the changes will not take effect until the next time the path is used. 
It is recommended that you modify paths only when they are not in use. 

To edit a path 

1. In Gateway Administrator, from the path tree, select the path that you want to edit. 

2. In the right pane of the Gateway Administrator application window, make your 
changes to the path. 

The items that appear here vary, depending on which type of path you clicked. If the 
application window displays a Configure Path or Configure Channel button, be sure 
to click these buttons to configure the path. 

To change a pooled connection path into a single connection path, delete all of the 
pooled ASCUs, GTIDs, or LNIATAs in the list box, and then add the new single 
connection path. To change a single connection path into a pooled connection path, 
type the ASCU, GTID, or LNIATA in the appropriate text box, and then click Add. 

3. From the Path menu, choose Save. 

Deleting a Path 
You can delete host paths in Gateway Administrator. 

To delete a path 

1. In Gateway Administrator, from the path tree, select the path that you want to 
delete. 

2. From the Path menu, choose Delete. 

-or- 
Right-click the path that you want to delete and then click Delete Path. 
If you delete a path that is currently in use, no disruption occurs in communication, 
but the networked PC will not be able to access the host the next time using that 
path. It is recommended that you delete paths only when they are not in use. 
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Monitoring Communication 
Gateway Monitor displays information about communication between the networked 
PCs, INFOConnect Airlines Gateway, and the host. Using the Gateway Monitor, you can 
check to see which paths are active and which aren’t. Additionally, you can determine 
how many users are connected and who is connected to the gateway. 
Using Gateway Monitor, you can close connections between the networked PCs and the 
host, and you can trace communication between a networked PC, the gateway, and the 
host to determine whether communication problems are occurring at the gateway.  
When you trace a session, you record all raw protocol data in a file called AtmGpSrv.log. 
This log file is located in the install folder on the server where Gateway Monitor is 
installed (by default, ..\Program Files\Attachmate\Infocnee\Gateway). Each time you 
trace a session, the newly recorded data is appended to this file. 
The information in this log file can indicate whether or not communication problems are 
being caused by the Airlines Gateway. If the data provided by the trace does not indicate 
that the gateway is the source of the problem, you might need to trace the path using the 
INFOConnect Manager. This provides trace information at the transport level rather than 
at the gateway level. For more information, refer to Tracing INFOConnect Paths. 
If you’re not familiar with raw protocol data, you can send the log file to Attachmate 
Customer Support for review. 

Starting Gateway Monitor 
To start Gateway Monitor, click Monitor in the Gateway Administrator path tree or use 
the following procedure to launch Gateway Monitor in its own window. 

To start Gateway Monitor 
1. At the server where INFOConnect Airlines Gateway is installed, log on as an 

administrator. 
You must be logged onto the server as an administrator or as a user with 
administrator privileges to view any data using this utility. If you are not logged on 
as an administrator, Access Denied appears in the Server Status area of the 
application window, and the rest of the application window is blank. 

2. From the Start menu, select Gateway Monitor from the Attachmate INFOConnect 
Airlines Gateway programs group. 

Data Provided by the Gateway Monitor 
The Gateway Monitor application window displays the following data: 
• The status of the gateway (Active if it’s running, Inactive if it’s not, or Access Denied 

if you are not logged onto the server as an administrator). 

• The number of sessions currently available to receive connection requests from the 
networked PCs (the default value is 5). 
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• The number of currently active sessions (that is, the number of networked PCs that 
are currently connected to the gateway). 

• The following information for the currently active sessions: 

Column Description 

ID The internal number that the gateway uses to identify the 
session with the host 

Status The status of the session (only Open is currently supported) 

User The IP address of the networked PC 

Host session The name of the path and the station name or terminal ID 
associated with it 

From client The number of buffers sent from the networked PC to the 
gateway 

To host The number of buffers sent from the gateway to the host 

From host The number of buffers sent from the host to the gateway 

To client The number of buffers sent from the gateway to the networked 
PC 

Trace The tracing status of the session (On if tracing is currently 
occurring, Off if it is not) 

Client session The listening path that is in use by the particular session (only 
ATM_TCP_1 is currently supported) 

Gw protocol The high-level protocol used to communicate between the 
client and Gateway (only AIRGATE is currently supported) 

Nw protocol The low-level transport protocol used between client and 
gateway (only TCP is currently supported) 

 

Gateway Monitor can monitor only the sessions managed by the gateway on the 
same server where this utility is installed. 
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Closing a Session 
You can close one or more active sessions from within Gateway Monitor. 

To close a session 
1. From the Active tab, select the ID of the session that you want to close. 

You can select multiple sessions to close them simultaneously. 
2. Click Close. 

A message indicating that the connection is being closed is sent to the networked 
PCs, the sessions are closed, and the names of the sessions disappear from the Active 
Sessions list box. 

Tracing a Session 
You can trace one or more active sessions from within Gateway Monitor. 

To trace a session 
1. Do one of the following: 

To begin tracing Do this 

All sessions as soon as each 
connection request is received 
by the gateway 

On the Listening tab of the Monitor screen, select 
an ID and click Trace. As client sessions become 
active they will be traced immediately. 

One or more currently active 
sessions 

Go to step 2. 

 

2. From the Active tab, select the ID of the session that you want to trace.  

You can select multiple sessions to trace them simultaneously. 
If you select more than one session listed on the Active tab, all of the sessions must 
have the same Trace status. For example, all of the selected sessions must have a 
Trace status of Off (to begin tracing all of them) or On (to stop tracing all of them). 

3. Click the Trace button. 

All raw protocol data and any data typed at the networked PC are recorded in a file 
called AtmGpSrv.log. This log file is located in the install folder on the server where 
Gateway Monitor is installed by default, ..\Program Files\Attachmate\Infocne\ 
Gateway. Each time you trace a session, the newly recorded data is appended to this 
file, so be sure to delete the file when you are finished with it to ensure that it does 
not become too large. 
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Appendix A: Using CnfEdit 
Some user applications may require a file with the extension .cnf to hold translation 
tables and other communications data. A .cnf file is in binary format and can only be 
edited using the CnfEdit program. Several different options can be modified using 
CnfEdit. Some are not used with current products, but are retained for compatibility 
with older gateway products. 

Notes:  

• Take great care when changing .cnf values. Do not change a value unless you are 
sure that the new value is valid. 

• When you update a .cnf file, the changes do not take effect until the product using 
the file is restarted. 

To use CnfEdit 

1. From the command line, navigate to Infocnee/Cnf and locate the .cnf file with which 
you want to work. 

2. From the command line, type:  

path/CnfEdit 

 where path is the path to CnfEdit. 

3. Press ENTER.  

The File Selection screen is displayed. 

4. Type the name of the .cnf file you want to edit, then press ENTER. 

The Configuration Categories menu is displayed. The column on the left provides a 
list of six categories. When you move the cursor over a category name, the column 
on the right provides a list of all the options in that category. 

5. Move the cursor over the category containing the options you want to edit, and then 
press ENTER. A new screen for editing the options in that category is displayed. 
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CnfEdit Categories and Options 

Category Option/Description 

IA Level Data Entry Airline Code 
The airline code will be set correctly when you receive the 
.cnf file. Do not change this code unless you are sure that 
the current code is not correct. 

Interchange Address 
Retained for compatibility with other gateway software. 
Do not set any values for this parameter. 

Host Type 
The host type will be set correctly when you receive the 
.cnf file. Do not change the host type. 

 Code  Host  

 00 
01 
02 
03 
04 
05 
06 
07 
08 
09 
0A 
0B 
0C 
0D 
0E 
0F 
10 
11 
12 
14 
15 
 
16 

Any host type not listed here 
SABRE 
SABRE (FOS) 
British Airways (BABS) 
Continental 
CPARS 
JALCOM 
KLM (CORDA) 
QANTAS (QANTAM) 
Worldspan (PARS) 
Apollo 
Egypt Air 
El Al (Israel Airlines) 
Thai Airways 
Canadian Airlines 
Garuda 
Abacus 
Amadeus 
Apollo 2915 
Shares 
System One/Amadeus (Unison ALC  
    specification) 
Turkish 

 SITA Message TA 
Retained for compatibility with other gateway software. 
Do not set any values for this parameter. 

 Response Interchange Address 
Retained for compatibility with other gateway software. 
Do not set any values for this parameter. 

TA Tables Retained for compatibility with other gateway software. 
Do not set any values for this parameter. 
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Category Option/Description 

Screen Translate 
Tables 

Because screen translation is a two-way process, two 
screen translate tables are supplied with the correct 
settings for your host. One is used to translate data going 
to the host; the other is used to translate data coming from 
the host. Do not change the setting unless you are certain 
that you are entering correct values. 

Any value may be entered into the tables and very little 
validation is carried out; therefore, the user must ensure 
that the data input is correct. 

Communications This screen displays all of the items in the configuration 
file that are associated with communication between the 
gateway and the host. Care should be taken when 
changing these values as it is possible to select 
combinations of values that will prevent data 
transmission. 

The Help screen at the bottom right of the screen displays 
further information about the item situated at the cursor, 
and also indicates the type of data expected as input. 

Printer Translate Because printer translation is a one-way process, from the 
host to the printer, only one table is required. Do not 
change the setting unless you are certain that you are 
entering correct values. 

Most printer character translations will be the same as the 
display translation. However, some characters will be 
different. No more than 15 differences are allowed 
between the display and printer translation tables. If there 
are more than 15 differences, a warning message is 
displayed. At this point, it is possible to edit either table 
until only 15 differences between them are outstanding. 
The file cannot be saved if there are more than 15 
differences. 

Printer Escape These options are not used. 
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Appendix B: Error Messages 
The following table lists Gateway Administrator error messages and suggested 
responses. For information about the error messages associated with each transport, refer 
to the online Help. 

Error Message Description/Recommendation 

A host channel with that name 
already exists. 

Choose a different name for the new SABRE 
Host Channel and try again. 

A Host Connection with that 
name already exists. 

You cannot add a host connection that has the 
same name as an existing host connection. 
Choose a new name (up to 15 characters) and try 
again. 

A path with this name already 
exists. Do you want to 
overwrite it with the one you 
just created? 

You cannot add a path that has the same name 
as an existing path. Choose a new name (up to 
15 characters) and try again. 

A Pool with that name already 
exists. 

Choose a new name for the address pool and try 
again. 

A GTID pool must be selected.  Select a GTID Pool from the list. 

A specific GTID must be 
selected. 

Select a GTID from the list. 

An error occurred while trying 
to add a new Host Connection. 

A severe error occurred while trying to create a 
new MATIP Host connection. Contact 
Attachmate. 

An error occurred while trying 
to add a new Pool. 

A severe error occurred while trying to create a 
new address pool. Contact Attachmate. 

An error occurred while trying 
to add to the Address Pool. 

A severe error occurred while trying to add an 
address to a Pool. Contact Attachmate. 

An error occurred while trying 
to delete from the Address Pool. 

A severe error occurred while trying to delete an 
address from a Pool. Contact Attachmate. 

An error occurred while trying 
to delete the current Host 
Connection. 

A severe error occurred while trying to delete a 
MATIP Host connection. Contact Attachmate. 

Changes are pending. Please 
Save or Cancel the current 
updates before continuing. 

Save or cancel pending changes before 
continuing. 
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Error Message Description/Recommendation 

Changes have been made. 
Would you like to save them? 

You tried to switch focus from one path to 
another without saving your changes. Click OK 
to save the changes or Cancel to cancel the 
changes. 

Host Connections names must 
be between 1 and 15 
alphanumeric characters long.  

Choose a new name and try again. 

Invalid SABRE address value. SABRE LNIATA address bytes must be a 
hexadecimal number between 0x00 and 0xFF, 
inclusive. Choose a new value and try again. 

MATIP address bytes must be a 
hexadecimal number in the 
range 0x00-0xFF, inclusive.  

Choose a new value and try again. 

Memory error. Insufficient memory is available to run Gateway 
Administrator. Close any unneeded applications 
and try again. 

Old password does not verify, 
try again? 

When changing the password, you specified an 
old password that does not match the existing 
password. Retype the old password and try 
again. 

Password does not verify, try 
again? 

The password you typed to access Gateway 
Administrator is not valid. Retype the password 
and try again. 

Please specify a DNS name or IP 
address for the host. 

Type an IP address or Domain Name for the 
SABRE Host. 

Please specify a new host 
channel name.  

Type a name for the new SABRE host channel. 

Please specify a Pool name.  Type a name for the address pool. 

Request to delete item in use 
rejected. You must first delete 
all references to the item. 

You tried to delete an item that is in use. For 
example, you might have tried to delete an INT1 
environment that was in use by an INT1 path. 
You must remove all references to the item that 
you want to delete before you can delete it. 



Error Messages 

27 

Error Message Description/Recommendation 

Sorry this Install Type is not 
supported by this version of 
Gateway Administrator. 

You tried to use Gateway Administrator with a 
version of the INFOConnect database that it 
does not support. Make sure that the Windows 
registry 
(HKEY_LOCAL_MACHINE\SOFTWARE\Atta
chmate\AlcGW\-
WorkstationUser\Preferences\DirIC32CFG) 
specifies a valid INFOConnect database and try 
again. 

Spaces are not allowed in the 
fieldname. 

You typed a space in a field (such as Class Name 
or Channel Name) that does not allow spaces. 
Use underlines or hyphens instead of spaces and 
try again. 

The two copies of your new 
password are not the same, try 
again? 

The password you typed in the Confirm New 
Password text box does not match the password 
you typed in the New Password text box. 
Retype either the New Password or Confirm 
New Password passwords and try again. 

There are no entries to delete. There are no address pools to delete. 

This Host Connection is still in 
use. Continue?  

The Host connection is still in use by at least one 
Host Path. 

You can not have a blank 
password. 

You must specify a password in order to start 
Gateway Administrator. Type a password in the 
New Password and Confirm New Password text 
boxes and try again. 

You do not have a valid 
INFOConnect installed, or it’s 
been corrupted. 

Gateway Administrator cannot open the 
INFOConnect database. The database might not 
be the appropriate one, or the file might have 
become corrupted or damaged. Make sure that 
the Windows registry 
(HKEY_LOCAL_MACHINE\SOFTWARE\Atta
chmate\AlcGW\-
WorkstationUser\Preferences\DirIC32CFG) 
specifies a valid INFOConnect database and try 
again. If necessary, reinstall INFOConnect 
Airlines Gateway. 

You do not have INFOConnect 
installed, or it’s not accessible at 
this time. 

Gateway Administrator could not find the 
INFOConnect database. Make sure that the 
database resides in the Windows folder on the 
server where INFOConnect Airlines Gateway 
was installed and try again. If necessary, 
reinstall INFOConnect Airlines Gateway. 
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Error Message Description/Recommendation 

You must have a fieldname to 
continue. 

Type a value for the specified field and try 
again. 
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Glossary 
Gateway Administrator 

An application that you can use to add, modify, and delete paths or path-related 
components, and to start, stop, or monitor the gateway service. 

host 

A mainframe, mini-computer, or information hub with which the networked PCs 
communicate. 

host path 

A path that is configured to establish a connection between INFOConnect Airlines 
Gateway and a host. 

INFOConnect Connectivity Services 

A package of INFOConnect products that includes INFOConnect Manager and other 
INFOConnect software. 

INFOConnect database 

A file (IC32.cgf) usually located in the Gateway folder that contains information 
about all the INFOConnect packages that have been installed, as well as all the path 
templates, library channels, and paths that have been created. 

INFOConnect Manager 

The application that runs in the background each time you run an INFOConnect 
product and that controls interaction between accessories and transports. 

You can also use this application to create, modify, and delete paths; set 
administrator and user-level security; control user access to configuration; and set 
user preferences. INFOConnect Manager also lets you switch between sessions, clear 
sessions, and view session status. 

listening path 

A path that is configured to receive connection requests and establish 
communication between the networked PCs and INFOConnect Airlines Gateway. 
This path is created automatically when the Gateway Administrator is first run. 

path 

A named set of configuration data required to establish communication between the 
PC and a host. 

path tree 

The tree that appears in the left pane of the Gateway Administrator application 
window. At the top of the path tree is an icon for the server where the INFOConnect 
database is located (such as C:\WINNT). As you create paths, those paths also 
appear in the tree. 
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pooled connection path 

A path that contains configuration data for multiple connections to a host. 

single connection path 

A path that contains configuration data for a single connection to a host. 

transport 

The communication software that enables a PC to communicate with a host via a 
specific type of network. For example, the INFOConnect TCP/IP Transport enables 
communication via a TCP/IP network. 
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